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About this guide

Assumptions

The instructions in this guide assume that you have the following:
• Experience working on mechanical equipment 
• An understanding of the Bravo Platform
• Familiarity with the VWorks software

What this guide covers

This guide describes how to inspect and replace chimneys in the following Agilent 
wash station models. 

Wash station name, 
Agilent part number 
(internal part number)

 Description Liquid-handling 
head 
compatibility

AssayMAP 
cartridge 
compatibility

96 Channel Wash 
Station, G5498B#90  
(G5409-60125)

Equipped with 96 wide-bore chimneys (part 
number G5409-68004) and a bracketed 
platepad to secure it. 
This model supersedes the following wash 
station models listed in this table.
Note: Use only the wide-bore chimneys with this 
wash station model. 

Bravo 96AM 
Head, and 96LT, 
96ST heads

5 µL or 25 µL 
cartridges

96AM Wash Station, 
G5498B#57 
(11961-311)

Equipped with 96 standard-bore chimneys (part 
number 15586-002) before June 2020 or 
96 wide-bore chimneys (part number 
G5409-68004) after June 2020. This model 
also has a bracketed platepad to secure it. 
This wash station may be retrofitted with the 
wide-bore chimneys (part number 
G5409-68004).

Bravo 96AM 
Head, and 96LT, 
96ST heads

5 µL cartridges
25 µL cartridges 
only if upgraded 
with white, wide-
bore chimneys

96 Well MicroWash 
Reservoir, 
G5498B#51  
(11961-301)

Equipped with 96 standard-bore chimneys (part 
number 15586-002). The setscrews in the deck 
platepads are used to secure this wash station 
in place.

96LT and 96ST 
heads

Incompatible
Using this wash 
station on the 
AssayMAP 
Bravo Platform 
can cause a 
head crash. 



3

About this guide

Bravo 96 Channel Wash Station Maintenance Guide

Related user guides and where to find them

You can access the Bravo user documentation in the VWorks Knowledge Base using 
any of the following methods:
• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows 10 desktop, select Start  > All Apps > Agilent Technologies > 
VWorks Knowledge Base.

• Go to www.agilent.com/chem/askb.
For AssayMAP user documentation, see the Literature Library page in the Protein 
Sample Prep Workbench.

Contacting Agilent Technologies

Web: https://www.agilent.com
Contact page: https://www.agilent.com/en/contact-us/page
Documentation feedback: documentation.automation@agilent.com

For information on… See…

Potential safety hazards of the platform 
and how to avoid them
Installing and setting up the Bravo Platform

G5562A, G5563A Bravo Platform 
Safety and Installation Guide

Installing and setting up the AssayMAP 
Bravo Platform

AssayMAP Bravo Platform Installation 
Guide

How to use Bravo Diagnostics Bravo Platform User Guide

https://www.agilent.com
https://www.agilent.com/en/contact-us/page
mailto:documentation.automation@agilent.com
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About the wash station

Overview

The wash station is a component of the Bravo autofilling station, as the following figure 
shows. 

Figure Example of autofilling station: wash station, Pump Module, tubing, and carboys 

How liquid flows through the wash station

Fresh wash liquid enters the wash station through two inlet ports (1), shown in the 
following figure. The wash liquid flows up through the chimneys, and the waste 
overflows from the chimneys and is removed through two outlet ports (2).

Figure Wash station (1) inlet ports and (2) outlet ports 

                                                        

2
1
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Types of wash station chimneys for 96 channel wash stations

The following figure and table describe the two types of wash station chimneys: 
• Wide-bore chimneys. The 96 Channel Wash Station (part number G5409-60125) 

comes equipped with the wide-bore chimneys.
• Standard-bore chimneys (formerly, large-bore chimneys). The 96AM Wash Station 

(part number 11961-311) were previously equipped with the standard-bore 
chimneys, but as of June 2020 they ship with the wide-bore chimneys. The 96 Well 
MicroWash Reservoir/Tip Wash Station (part number 11961-301) ships with the 
standard-bore chimneys.

Note: If you are unsure of the chimney type that you have in the wash station, see 
“Measuring your chimney to verify type” on page 37. 

Feature Wide-bore chimney Standard-bore chimney

Part number Agilent G5409-68004 (pack of 100) Agilent 15586-002 (pack of 100)

Color White, opaque Neutral, semi-translucent

Geometry Tapered diameter with wider top 
opening and narrower bottom opening.

Very slight taper from top to bottom 
opening. 

Correct chimney 
orientation

Wider opening at top end; white bump 
for alignment closer to top end

White dot for alignment closer to top end 

Liquid-handling head 
compatibility

All Agilent 96-channel heads and 
pipette tips

All Agilent 96-channel heads and pipette 
tips

AssayMAP cartridge 
compatibility

AssayMAP 25-µL and 5-µL cartridges AssayMAP 5-µL cartridges only
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When to replace the chimneys

The wash station chimneys require replacement for the following reasons:
• Irregular or damaged chimneys. See the following figure for examples.
• Incompatibility with AssayMAP 25-µL cartridges. The standard-bore chimneys are 

not compatible with the AssayMAP 25-µL cartridges. Before using the 25-µL 
cartridges, replace the standard-bore chimneys with the white wide-bore chimneys. 
See “Types of wash station chimneys for 96 channel wash stations” on page 5.

CAUTION
To avoid a hardware crash and equipment damage, ensure that the wash station 
contains white wide-bore chimneys when using the AssayMAP 25 µL cartridges. 

Determining if the chimneys are in good condition

Carefully inspect the chimneys in the wash station to ensure that they are:
• In good condition and free of deformities and irregularities. See the following figure 

for examples.
Chimney irregularities or damaged chimneys can prevent wash solution from 
forming domes atop the chimneys, which will decrease the ability to wick off the 
droplets from the syringe probes of the Bravo 96AM Head and may introduce 
variability in the assay.

• Of equal height. When the chimneys are fully seated in the wash station their height 
should be consistent (less than 1 mm difference in height). If any chimneys seem 
higher than the others, push them down to the hard stop. See step 8 in the 
following replacement procedure.

• Installed in the correct orientation. See “Types of wash station chimneys for 96 
channel wash stations” on page 5.
Note: Incorrect orientation is only possible on the standard-bore chimneys. 

• Clean and free of any debris.

Figure Close up views of wash station chimneys

Standard-bore chimneys: Good condition Damaged standard-bore chimneys  
(possibly from a head collision)
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Replacing the chimneys

WARNING
The probes of the AssayMAP Bravo 96AM Head are sharp and can scratch you if 
they brush across your hand. A probe scratch can expose you to any contaminants 
remaining on the probes. Wear gloves and use extreme caution to avoid brushing 
against the probes.

Before you start

Required tools and materials
• Replacement chimneys and chimney insertion tool (included in the package)

Ensure that you have the correct chimney type. See “Types of wash station 
chimneys for 96 channel wash stations” on page 5. 
To verify the chimney type installed in your wash station, see “Measuring your 
chimney to verify type” on page 37.
Note: If you do not have an insertion tool, use a rubber pad between your thumb 
and the chimney to protect your thumb while pressing down on each chimney. 

• Needle-nose pliers to remove the old model or defective chimneys from the wash 
station.

IMPORTANT
Ensure that all chimneys are of the same type, wide-bore or standard-bore. Ensure you 
discard any chimneys that you remove. Using pliers on a chimney will permanently 
damage the chimney. 

IMPORTANT
Use only wide-bore chimneys with the 96 Channel Wash Station (part number 
(G5409-60125).

Workflow
Step For this task... See...

1 Inspect the chimneys for damage 
and irregularities.

“Determining if the chimneys are in good 
condition” on page 6

2 Replace the chimneys. “Replacing the chimneys” on page 7

3 • AssayMAP Bravo Platform. 
Verify the teachhpoint at the 
wash station and adjust it as 
necessary.

“AssayMAP Bravo: Verifying the wash 
station teachpoint” on page 11

• Bravo Platform. If you replace 
standard-bore chimneys with 
wide-bore chimneys, verify 
the x- and y-axes of the 
teachpoint at the wash 
station.

Bravo Platform User Guide
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Chimney replacement procedure

To replace the chimneys:
1 Exit the Protein Sample Prep Workbench and VWorks software.
2 On the side of the Bravo Platform, press the power switch to the off (o) position.
3 Gently, move the Bravo head manually to position it so that you have unobstructed 

access to the wash station installed on the deck. 
For example, if the wash station is installed at deck location 1, move the head to the 
far right side over deck location 3, as the following figure shows.

Figure Bravo head positioned at deck location 3

4 Using needle-nose pliers, pull out the defective (or older model) chimney from the 
wash station.

IMPORTANT
Ensure that you discard any chimneys that you remove from the wash station. Using 
pliers to remove the chimneys will damage them.

5 Orient the new chimney with the little alignment bump (wide-bore chimney) or dot 
(standard-bore chimney) as the figure shows, and then insert the chimney bottom 
end into the hole in the wash station. 
Note: All the chimney alignment bumps or dots should face the same direction.

4 Start up the platform and verify that all the chimneys work consistently using 
one of the following procedures:

• AssayMAP Bravo Platform “AssayMAP Bravo: Testing the wash 
station” on page 20

• Bravo Platform “Testing the wash station in a Bravo 
Platform” on page 21

Step For this task... See...

Bravo
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CAUTION
To avoid a hardware crash and equipment damage, ensure that the chimneys are 
oriented correctly in the wash station. 

6 Position the (1) insertion tool atop the (2) chimney, and press straight down on the 
insertion tool to install the chimney until you feel a hard stop. The chimney touches 
the bottom surface of the wash station when fully seated.

CAUTION
Use care while pressing down in a vertical motion to avoid bending the chimneys 
during installation.

Wide-bore chimney orientation Standard-bore chimney orientation

Alignment bump faces the front of the wash station.
Larger opening is at the top. This is the only 
orientation that will fit.

Little dot on side of chimney is at the top and faces 
wash station rear (side with ports).
Even though this chimney fits in either orientation, the 
size of the top and bottom ends are different.

Front

Bump
Dot

Rear

1

2
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7 Repeat steps 1 to 5 to replace any other chimneys.
8 Carefully inspect the chimneys in the wash station to ensure proper alignment:

• All the chimney tops are level with each other (less than 1 mm difference in 
height). 
If any chimney is taller than the others, use the insertion tool or your thumb to 
press down on the chimney so that it touches the bottom surface (hard stop) 
of the wash station. 

• All the alignment bumps or dots on the chimneys are facing the same 
direction.

Figure Example of wide-bore chimney alignment: tops level and alignment bumps aligned

IMPORTANT
Good condition chimneys and consistent chimney height are critical for proper 
functioning of the wash station.

BravoBravo
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AssayMAP Bravo: Verifying the wash station teachpoint 

The syringes in the Bravo 96AM Head are fragile and can be damaged if the head 
collides with an object on the deck. To prevent the potential of collisions at the wash 
station, you must verify the teachpoint at the wash station after installing new 
chimneys.
For this procedure, you will determine if the alignment of the syringe probes in the 
Bravo 96AM Head are still centered in wash station chimneys. If an adjustment is 
necessary, only the x- and y-axes will be adjusted.

Before you start

Ensure the following:
• The emergency-stop pendant is within easy reach.

• No pipette tips or cartridges are on the syringes of the head.

WARNING
The Jog/Teach tab in Bravo Diagnostics poses an increased risk of collision because 
the jog controls enable you to move the head without regard to items on the Bravo 
deck. To prevent potential injury and damage to the device, use extreme caution 
when using the Jog/Teach tab controls. 

WARNING
The red Stop motors button in Bravo Diagnostics does not perform an immediate 
stop. To perform an emergency stop, press the red button on the emergency-stop 
pendant.

Workflow

Workflow for setting the teachpoints
Step For this task... See...

1 In the Bravo Diagnostics dialog box, 
initialize the AssayMAP 1 profile. 

“Initializing AssayMAP 1 profile” on 
page 12

2 Verify the wash station teachpoint for 
the AssayMAP 1 profile, and adjust it if 
necessary.

“Verifying and adjusting the 
teachpoint for AssayMAP 1 profile” 
on page 14

3 If you updated the AssayMAP 1 profile, 
use the AssayMAP Update 
Teachpoints protocol to update the 
remaining profiles.

“Updating the teachpoint 
adjustment in the remaining 
profiles” on page 17
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Initializing AssayMAP 1 profile

1 Ensure that the Protein Sample Prep Workbench and VWorks software is closed.

2 To start the VWorks software, click the VWorks icon  on the desktop.

3 In the VWorks window, click Log in on the toolbar. In the User Authentication dialog 
box, type your user name and password, and click OK.

4 On the VWorks toolbar, ensure that Simulation is off is displayed.

5 In the VWorks window, click File > Open. 
6 In the Open dialog box, ensure the file type is Device Files (*.dev), select the 

following file, and then click Open: 
C:\VWorks Workspace\Workbench\Device Files\AssayMAP Bravo.dev

7 Click No when the Would you like to initialize devices now? message appears.
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8 In the Devices tab (AssayMAP Bravo.dev), select the device and then click Device 
diagnostics. 

9 In the Agilent Bravo Diagnostics dialog box, click the Profiles tab, and then do the 
following:
a Verify the Profile name is AssayMAP 1, and verify the Teaching tip type is 

250 µL.
b Click Initialize this profile.
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Verifying and adjusting the teachpoint for AssayMAP 1 profile

To verify and, if necessary, adjust the teachpoint:
1 In Agilent Bravo Diagnostics, click the Jog/Teach tab, and then click Location 1. 

Note: Additional accessories will appear in the image if you have configured 
them in this profile. 

2 In the Location list, locate the Z-axis box. Write down the Z-axis value on a piece of 
paper. You will use this value in a subsequent step.
Note: The Z-axis teachpoint value for deck location 1 is typically between 
105.2–105.8 mm for a standard height AssayMAP Bravo Platform and standard 
platepad.
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3 Move the head down so that you can verify the teachpoint as follows:
a In the Approach height above teachpoint box, type 50, and then click Approach.

b Carefully, use the Jog Axes controls to move the head down (z-axis) using 
small incremental steps until the tips of the probes are approximately 1 mm 
above the tops of the chimneys. To do this:
Set the jog increment (mm), and then click the Down +Z button. 
Reduce the increment value as the tips get closer to the wash station 
chimneys.

4 While syringe probe tips are in position just above the chimney tops, check the 
alignment to see if the probe tips are centered in the chimneys:
• If no adjustment is necessary to center the probe tips, click Move to safe height 

at current X/Y position and then click Cancel to close Bravo Diagnostics without 
saving any changes. 
Proceed to “AssayMAP Bravo: Testing the wash station” on page 20.

• If an adjustment is necessary to center the probe tips, continue to step 5.
5 Carefully, use the Jog Axes controls to position the syringe probes so that they are 

centered over the corresponding chimneys in the x- and y-axes.
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6 When the probes and chimneys are aligned, use the Jog Axes controls to move the 
head down incrementally along the z-axis, using smaller and smaller jog 
increments until you reach the original Z-axis teachpoint value that you recorded in 
step 2. 
Note: This step will insert the probes into the wash station chimneys, which is a 
normal part of the teaching process.

7 When the position of the z-axis (as indicated by the Z-axis readout in the bottom 
right of the screen) matches the Z-axis value that you recorded in step 2, click 
Teach to set the new teachpoint for deck location 1. 

8 Click Move to safe height at current X/Y position. The head moves up and returns to 
a safe height above the wash station. 

                                                        



17

AssayMAP Bravo: Verifying the wash station teachpoint

Bravo 96 Channel Wash Station Maintenance Guide

9 In the Profiles tab, click Update this profile to save the new teachpoint. 

Updating the teachpoint adjustment in the remaining profiles

The AssayMAP Teachpoint Update protocol will set the teachpoints for all other 
profiles in the Protein Sample Prep Workbench based on the AssayMAP 1 profile.
Note: The AssayMAP Teachpoint Update protocol also automatically makes z-axis 
teachpoint adjustments for the GlykoPrep-Plus profile to accommodate the height of 
the Red PCR Insert at deck location 4, and the AssayMAP Normalization profile to 
accommodate the height of the Bravo Plate Riser at deck locations 2 and 6. 

Before you start
Ensure that you have the AssayMAP Teachpoint Update protocol (.pro), which is 
installed in the following location:
C:\VWorks Workspace\Workbench\Protocols\AssayMAP Teachpoint Update v1p0.pro
Note: The AssayMAP Teachpoint Update protocol is not designed to work in simulation 
mode.

To start the AssayMAP Teachpoint Update protocol:
1 In the VWorks window, click File > Open. The Open dialog box appears.
2 In the Open dialog box, ensure the file type is Protocol Files (*.pro). Locate the 

C:\VWorks Workspace\Workbench\Protocols folder, select the AssayMAP 
Teachpoint Update v1p0.pro file, and then click Open.



AssayMAP Bravo: Verifying the wash station teachpoint

18 Bravo 96 Channel Wash Station Maintenance Guide

3 When the following VWorks initialization message appears, click Yes. 

The AssayMAP Bravo.dev file opens, and the AssayMAP 1 profile initializes.
4 Ensure that the AssayMAP Teachpoint Update protocol is open in the VWorks 

window, and then click Start.
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5 In the Run Configuration dialog box, click Finish to start the protocol.

6 When the Update Teachpoints dialog box appears, click Continue to update 
teachpoints in all the other Workbench profiles based on the AssayMAP 1 profile.

 

7 When the WARNING dialog box appears, click Continue to complete the update.

8 Close the VWorks software.
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AssayMAP Bravo: Testing the wash station 

Before you start

Ensure that you verify the wash station teachpoint and adjust it as required. For details, 
see “AssayMAP Bravo: Verifying the wash station teachpoint” on page 11.

Starting up the AssayMAP Bravo Platform

To test the performance of the wash station, you run the Startup utility in the Protein 
Sample Prep Workbench. During the Startup protocol, carefully observe the fluid as it 
flows out of the top of the chimneys in the wash station. 

To start up the system:
1 Check the levels of the wash station source and waste carboys, and fill or empty as 

required.
2 Turn on the AssayMAP Bravo Platform and accessories.
3 Start the Protein Sample Prep Workbench, and open the Utility Library.

4 Open the System Startup/Shutdown utility .

5 Click Run Startup to initialize the AssayMAP Bravo Platform and accessories.
Note: If the wash station was allowed to dry, change the Wash Station Prime 
Duration setting from 10 to 60 seconds before clicking Run Startup. 

WARNING
When you initialize the Bravo Platform, the head and tie bar will move. To prevent 
injury, keep clear of the device while it is in motion.

6 During the Startup protocol, verify that all the wash station chimneys have liquid 
flowing through them.
• If all the chimneys are flowing evenly, the device is ready for operation.
• If no liquid is flowing through any of the chimneys, check to see if:

– Liquid is in the source carboy.
– The tubing is clamped into the pump heads.
– The tubing is routed correctly, and free of kinks or damage. 
Repeatedly run the Startup utility or increase the wash station prime duration in 
the Startup utility.
For more guidelines, see “Troubleshooting problems with the wash station” on 
page 35. 

• If no liquid is flowing through a subset of chimneys, suspect an airlock. Use a 
plastic transfer pipette or a 1 mL pipette to draw liquid through the problematic 
chimneys. Rerun the Startup utility, and repeat this step until all the chimneys 
are flowing freely. 
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Testing the wash station in a Bravo Platform

Before you start

If you did not uninstall the wash station, you do not need to verify the teachpoints for 
the wash station installed on a standard Bravo Platform. If you replaced the standard-
bore chimneys in the wash station with wide-bore chimneys, you should verify the 
teachpoint at the wash station.

CAUTION
If you uninstall and reinstall the wash station, the wash station teachpoint can shift. 
To prevent a potential crash, verify the wash station teachpoint in your Bravo profiles 
any time you reinstall the wash station. In addition, you should verify the wash 
station teachpoint if you replace standard-bore chimneys with wide-bore chimneys. 

For instructions on how to set and verify the Bravo teachpoints, see Bravo Platform 
User Guide.
To test the performance of the wash station, you run the Pump Reagent task in Bravo 
Diagnostics to pump liquid into the wash station. While running the task, carefully 
observe the fluid as it flows out of the top of the chimneys in the wash station. Verify 
that all the wash station chimneys have liquid flowing through them.

Starting up the Bravo Platform

To start up the system:
1 Check the levels of the wash station source and waste carboys, and fill or empty as 

required.
2 Turn on the Bravo Platform and accessories.
3 Start the VWorks software.
4 In the VWorks window, ensure that Simulation is off.

5 In the VWorks window, open the Bravo device file. 
To do this, click File > Open. In the Open dialog box, ensure the file type is Device 
Files (*.dev), select the file, and then click Open.
The default storage location for device files is C:\VWorks Workspace\Device Files
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6 Click No when the Would you like to initialize devices now? message appears.

7 Open Bravo Diagnostics as follows:
In the VWorks window, select the device in the Device tab (.dev), and click Device 
diagnostics. 

The Agilent Bravo Diagnostics dialog opens.
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8 To initialize your Bravo profile, click the Profiles tab, select the Profile name, and 
then click Initialize this profile.

WARNING
When you initialize the Bravo Platform, the head and tie bar will move. To prevent 
injury, keep clear of the device while it is in motion.

9 If the There appears to be a plate present error message appears, click Ignore and 
Continue to continue the homing process. 

10 When the Verify that it is safe to home the W-axis message appears, click Ignore to 
skip the w-axis homing for now. 
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Running the Pump Reagent task to fill the wash station

To run the Pump Reagent task:
1 In Bravo Diagnostics, click the Processes tab.

2 Select the following:

3 Click Execute command. 
4 Observe the fluid as it flows out of the top of the chimneys in the wash station. If all 

the chimneys are flowing evenly, the wash station is ready for operation.
To troubleshoot problems with the wash station, locate your problem in the 
troubleshooting table and try the solution. See “Troubleshooting problems with the 
wash station” on page 35. If the problem persists, contact Agilent Technical 
Support.

IMPORTANT
To home the w-axis, make sure that you reinitialize the profile before running a protocol.

Setting Value
Location Number of the deck location where 

the wash station is installed.
Labware at selected location 96AM Tip Wash Station
Command to execute Pump Reagent
Pump Reagent properties

Reservoir mode Fill
Pump speed (0–100%) 50%
Pump on time (1–600 s) 60 seconds
How often 1
Run second pump Yes
Second pump speed (0–100%) 60%
Use weigh station No
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Replacing a wash station

If the wash station requires replacement, use the following workflow.

Workflow

Step For this task... See...

1 Empty the wash station. “Emptying the wash station” on page 26

2 Uninstall the wash station. “Uninstalling the wash station” on page 30

3 Install the wash station. “Installing the wash station and connecting 
the tubing” on page 31

4 Verify the wash station teachpoint and adjust it, as necessary, for your configuration:

• AssayMAP Bravo Platform. Initialize the 
AssayMAP 1 profile and adjust the teachpoint for 
the wash station. Use the AssayMAP Teachpoint 
Update protocol to update the remaining profiles 
in the Protein Sample Prep Workbench.

“AssayMAP Bravo: Verifying the wash 
station teachpoint” on page 11

• Bravo Platform. Initialize your Bravo profile and 
verify the teachpoint for the wash station.

Bravo Platform User Guide

5 Start up the platform and verify that all the chimneys work consistently using one of the following 
procedures:

• AssayMAP Bravo Platform “AssayMAP Bravo: Testing the wash 
station” on page 20

• Bravo Platform “Testing the wash station in a Bravo 
Platform” on page 21
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Emptying the wash station

This topic describes how to use the Pump Reagent task in Bravo Diagnostics to empty 
any fluid from the wash station.

Before you start

WARNING
The probes of the Bravo 96AM Head are sharp and can scratch you if they brush 
across your hand. A probe scratch can expose you to any contaminants remaining on 
the probes. Wear gloves and use extreme caution to avoid brushing against the 
probes.

WARNING
When you initialize the Bravo Platform, the head and tie bar will move. To prevent 
potential injury, keep clear of the device while it is in motion.

CAUTION
To prevent potential equipment damage, ensure that the deck is clear of any 
obstacles before initializing the Bravo Platform.

CAUTION
Using an incorrect profile can cause equipment damage. Ensure that the profile is 
correct for the head type and deck configuration.

Running the Pump Reagent task to empty the wash station

To empty the wash station using the Pump Reagent task:
1 At the carboy that contains the wash solution, disconnect the lid and lift it so that 

the tubing is above the liquid level in the carboy.
2 AssayMAP Bravo Platform only. Ensure that the Protein Sample Prep Workbench is 

closed.
3 Start the VWorks software.

You can use the VWorks desktop icon or the Start menu on the Windows desktop 
to start the VWorks software. 

4 In the VWorks window, ensure that Simulation is off.

5 In the VWorks window, open the device profile:
To do this, click File > Open. In the Open dialog box, ensure the file type is Device 
Files (*.dev), select the file, and then click Open.
AssayMAP Bravo Platform only. Open AssayMAP Bravo.dev, which is installed in 
C:\VWorks Workspace\Workbench\Device Files
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6 Click No when the Would you like to initialize devices now? message appears.

7 In the Devices tab (for example, AssayMAP Bravo.dev), select the device and then 
click Device diagnostics. 

Figure AssayMAP Bravo.dev tab and Profile setting for AssayMAP 1 

The Agilent Bravo Diagnostics dialog opens.
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8 Click the Profiles tab, select the Profile name, and then click Initialize this profile.
For the AssayMAP Bravo Platform, make sure that you select the AssayMAP 1 
profile.

9 If the There appears to be a plate present error message appears, click Ignore and 
Continue to continue the homing process. 

10 When the Verify that it is safe to home the W-axis message appears, click Ignore to 
skip the homing of the w-axis for now.
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11 Click the Processes tab and run the Pump Reagent task as follows:

a Select the following:

b Click Execute command. The wash station empties.

Setting Value
Location Number of the deck location 

where the wash station is 
installed 
For the AssayMAP Bravo 
Platform, the location is 1.

Labware at selected location 96AM Tip Wash Station
Command to execute Pump Reagent
Pump Reagent properties

Reservoir mode Fill
Pump speed (0–100%) 50%
Pump on time (1–600 s) 60 seconds
How often 1
Run second pump Yes
Second pump speed (0–100%) 60%
Use weigh station No
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Uninstalling the wash station

IMPORTANT
Exit the Protein Sample Prep Workbench and VWorks software before you turn off the 
Bravo Platform.

WARNING
To prevent potential injury, turn off the Bravo Platform before you install or remove 
the wash station.

To uninstall the wash station:
1 On the side of the Bravo Platform, press the power switch to the off (o) position.
2 Gently, move the Bravo head manually to position it so that you have unobstructed 

access to the wash station installed on the deck. 
For example, if the wash station is installed at deck location 1, move the head to the 
far right over deck location 3, as the following figure shows.

3 On the left side as you face the front of the Bravo Platform, loosen the two 2-mm 
screws using a hex driver. Uninstall the bracket that secures the wash station to the 
platepad.

Figure Wash station secured with platepad brackets

Bravo
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4 On the opposite side of the platepad, loosen but do not remove the screws that 
secure the remaining bracket. Guide the wash station horizontal slot off the 
platepad bracket.

5 Lift the wash station off of the platepad.
For ease of handling, you may disconnect the tubing from the wash station using 
the quick-disconnect fittings.

Installing the wash station and connecting the tubing

CAUTION
On the AssayMAP Bravo Platform, ensure that you use either the 96 Channel Wash 
Station (part number G5409-60125) or the 96AM Wash Station. Using a different 
wash station model can result in a potential collision with the Bravo 96AM Head. 

Installing the wash station

Before you start

WARNING
To prevent potential injury, turn off the Bravo Platform before you install or remove 
the wash station.

The following procedure assumes that the platepad with brackets is already installed 
on the Bravo deck at deck location 1.

Figure Wash station installed at deck location 1

Bravo
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To install the wash station:
1 At the wash station deck location, ensure that the outer side bracket (next to the 

crosshairs) is removed from the platepad, or that the screws securing the bracket 
are loosened. 

Figure Bracket next to platepad crosshairs

Note: The wash station may be easier to install if you install one of the platepad 
brackets after the wash station is in position.

2 Install the wash station on the platepad as follows:
a Ensuring that the inlet and outlet ports are towards the rear of the deck, place 

the wash station on the platepad.
b Guide the platepad bracket into the wash station’s horizontal side slot.
c Re-install the remaining platepad bracket. Ensure that you guide the bracket 

into the corresponding horizontal slot on the wash station. Ensure that both 
brackets remain engaged as you tighten the bracket screws.

d Ensure that the wash station sits level on the platepad and that both brackets 
are holding the wash station securely in place. 

Figure Wash station secured with platepad brackets
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Tubing connections for the wash station

Reconnect any of the disconnected tubing. For reference, see the following figure. As 
the figure shows, the upper pump (A) is for the fill line and the lower pump (B) is for the 
empty line. 
Note: You specify which pump is for filling and which pump is for emptying in Bravo 
Diagnostics.

Figure Wash station fill line (A) and empty line (B)

To ensure proper chimney filling and waste emptying characteristics for the wash 
station, ensure that you use the proper tubing combination for the Pump Module. See 
the following figure and table.
                                                        

A

B
Source Waste
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Figure Tubing configuration
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Item Component Description

1 Source bottle Supplies the fill liquid for the wash station.

2 Waste bottle Collects the waste liquid that is pumped from the reservoir.

3 Tubing, 8-mm  
(5/16-in)

The empty-line tubing in the lower pump head, which is used for emptying the 
wash station. The larger diameter tubing ensures that the fluid is removed 
efficiently from the wash station

4 Tubing, 6.4-mm 
(1/4-in)

The fill-line tubing from the source bottle to the wash station, and empty-line 
tubing connections on either side of the 5/16-in diameter tubing. 
Note: The 5/16-in diameter tubing is too large for the quick-disconnect fittings 
and the wash station ports. So, you use a union connector (5) to splice the  
5/16-in tubing to the 1/4-in tubing.

5 Connector, union Joins the two sizes of tubing. 

6 Quick-disconnect 
fitting

Enables easy removal of the wash station and quick replacement of the tubing in 
the pump heads. The quick-disconnect fittings include an automatic-close valve. 
Fluid can flow only if a positive connection is made.

7 Inline pump filter Removes the particulates that can clog the chimneys in the wash station.

8 3-way connector Enables one tube to branch into two tubes at the input and output ports on the 
wash station.

9 Quick-disconnect 
fitting

Acts as a vent to prevent pressure from building up inside the bottle.
Plug a quick-disconnect fitting in the open hole in the carboy to act as a vent. If 
an extra quick-disconnect fitting is not available, loosen the lid to allow air to 
vent.
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Troubleshooting problems with the wash station

Problem Potential causes Solution

Liquid flow is 
constricted or 
insufficient in all the 
chimneys of the wash 
station.

The source carboy does 
not have any liquid.

Ensure that the source carboy is filled.

A pump head is not 
closed.

Ensure that the flip-top cover on each pump head is 
closed.

No liquid is in the tubing. Run the pumps for 30 to 60 seconds to drive liquid 
through the length of the tubing. 
For an AssayMAP Bravo Platform, run the Startup utility 
with a longer run time.

The tubing is not routed 
properly, the tubing is 
kinked or blocked, or the 
tubing is worn where it is 
clamped onto the pump 
head.

Inspect the tubing to verify that it is routed properly and 
in good condition. Check for kinks and damage to the 
tubing. Reroute and replace the tubing if necessary.
If the tubing is worn where it is clamped onto the pump 
head, replace the tubing going through the pump head.

The tubing diameter of the 
fill line is the wrong size, or 
the pump head clamp is 
too tight for the tube size.

Replace the tubing on the fill line using the correct 
diameter tubing. See “Tubing connections for the wash 
station” on page 33.
If necessary adjust the pump head clamp, see the Pump 
Module User Guide.

The inline filter is clogged. Replace the inline filter.
See “Tubing connections for the wash station” on 
page 33.

Liquid is not flowing 
through a subset of 
the chimneys in the 
wash station.

The chimneys are blocked 
or damaged.

To resolve the problem chimneys:

1 Use a plastic Pasteur or 1 mL pipette to quickly 
aspirate liquid through the chimneys that are not 
flowing. 
Test the wash station again to verify that the 
chimneys are flowing. If the problem persists, 
repeat this step several times.

2 If the problem persists, replace the problematic 
chimneys. See “Replacing the chimneys” on page 7.
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Waste is 
accumulating in the 
wash station.

The waste carboy is not 
properly vented and the 
carboy lid is too tight 
causing pressure to build 
within the carboy.

Plug a quick-disconnect fitting into the open hole in the 
carboy to act as a vent and prevent pressure from 
building up inside the bottle.
If an extra quick-disconnect fitting is not available, 
loosen the lid to allow air to vent.

A pump head is not 
closed.

Ensure that the flip-top cover on each pump head is 
closed.

The tubing is not routed 
properly, the tubing is 
kinked or blocked, or the 
tubing is worn where it is 
clamped onto the pump 
head.

Inspect the tubing to verify that it is routed properly and 
in good condition. Check for kinks and damage to the 
tubing. Reroute and replace the tubing if necessary.
If the tubing is worn where it is clamped onto the pump 
head, replace the tubing in the pump head with fresh 
tubing.

The tubing diameter of the 
fill line is the wrong size, or 
the pump head clamp is 
too tight for the tube size.

Replace the tubing on the fill line using the correct 
diameter tubing. See “Tubing connections for the wash 
station” on page 33.
If necessary adjust the pump head clamp, see the Pump 
Module User Guide.

Tubing creeps through 
the pump head 
instead of being 
secured in place.

The pump head clamp is 
too loose for the tube size.

Adjust the tubing clamp for the tube size. See the Pump 
Module User Guide.

The tubing is crushed 
or damaged in the 
pump head.

The pump head clamp is 
too tight for the tube size.

Adjust the tubing clamp for the tube size. See the Pump 
Module User Guide.

The fluid in the wash 
station chimneys is 
rapidly emptying when 
the pumps are not 
running. 

The tubing is worn where 
it is clamped onto the 
pump head.

Replace the worn tubing in the pump head with fresh 
tubing.

Wash station 
chimneys are sticking 
to AssayMAP 25 µL 
cartridges, or 25 µL 
cartridges are sticking 
to the chimneys.

The wash station has the 
standard-bore chimneys 
and they are installed 
upside down.

To avoid a potential crash, ensure that the wash station 
contains white wide-bore chimneys if you are using the 
25 µL cartridges. See “When to replace the chimneys” 
on page 6.
To avoid a potential crash, ensure that the chimneys are 
properly oriented in the wash station. See “Replacing 
the chimneys” on page 7.

Problem Potential causes Solution
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Measuring your chimney to verify type

If you are unsure of the chimney type that you have, you can use the following figure as 
a tool to measure a chimney. You can do this even while the chimney is installed in the 
wash station.

To check the chimney type:
1 Print out this page, and cut out the figure using the cut line as a guide.
2 Visually inspect the vertical surface of your chimney for the following:

• Wide-bore chimney. Small white bump is located closer to the top end.
• Standard-bore chimney. Small white dot is located closer to the top end.

3 Align the dimension marks at the top of this drawing above the top opening of the 
actual chimney to confirm the size. 
The radius of the wide-bore chimney is larger that the standard-bore chimney. See 
the following figures for examples.

Standard-bore
chimney

Wide-bore
chimney

Bottom end

3.68 mm4.72 mm

Scale 1:1

White bump White dot

Cut line Cut line
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Figure Wide-bore chimney and drawing aligned atop chimney

Figure Standard-bore chimney and drawing aligned atop chimney

Standard-bore
chimney

Wide-bore
chimney

3.68 mm4.72 mm

White dot

Drawing aligned 
atop chimney Mismatch

Top of wide-bore chimney

White bump

Standard-bore
chimney

Wide-bore
chimney

3.68 mm4.72 mm

White dot

Top of standard-bore chimney

Drawing aligned 
atop chimney Mismatch

White bump
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